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GWLM:
A helpful free tool to unlock the complexities of Db2 WLM

Paul Bird
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Session code: D06
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Tired of trying to figure out your workload management configuration from dense db2look output? Having trouble making even simple changes to your
system without mistakes? Unable to remember all the DDL options available? Come learn about the free IBM Graphical Workload Manager (GWLM) tool
that helps to unfold and make clear the mysteries of Db2 workload management in a simple, visual manner!

Paul Bird is a senior technical staff member (STSM) in the Db2 development organization. For the last 25+ years, he has worked on the inside of the DB2
for Linux, Unix, and Windows product as a lead developer and architect with a focus on such diverse areas as workload management, monitoring,
security, upgrade, and general SQL processing. You can reach him at pbird@ca.ibm.com.
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Objectives

Y #IDUGDb2

* Learn about what GWLM is and how you can get it

* See how GWLM transforms even complex db2look output into
human-comprehensible diagrams

* Use GWLM to explore the different parts and options of Db2
workload management

* Learn how to use GWLM to generate DDL for both new and modified
configurations
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Motivation

* In order to properly tune and manage a Db2 workload management

configuration, you must understand it

* You can’t change a configuration you don’t understand, especially if itis in
production!

* Understanding WLM means clearly knowing what has been defined,
what is active, and how work will flow through the system

* The tool commonly used to look at WLM is db2look

* i.e. “db2look —d <dbname> —wIm”
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But it doesn’t have to be, thanks to GWLM!
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The IBM Graphical Workload Management tool (aka GWLM) helps translate oodles of db2look output into clear, graphical images that you can quickly
comprehend and easily explore in depth.
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The IBM Graphical Workload Management Tool (GWLM)

* Whatis it?
* A proof-of-concept experiment to explore the possibilities of a more natural
representation for Db2 workload management
* An application written using Adobe Flex and running under Adobe Air (and Java)

e Whatis it intended to do?

* Provide a visual overview of a workload management (WLM) configuration
+ Allow you to explore and manipulate the details in an intuitive manner

»Make all our (WLM) lives easier ©

GWLM was created as an exercise to explore better ways to represent a Db2 WLM configuration in a GUI tool.

GWM is intended to display WLM in a way that shows you show at a glance how work is categorized and controlled and also allow you to explore and
manipulate that configuration in a natural, intuitive manner.

The practical motivation was to make it easier for people who have to review and tune WLM configurations by speeding up one of the most painful parts
of the process: understanding the current configuration.
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What else you need to know about GWLM

* Itis provided FREE, AS~-IS for your use and exploration
+tIMPORTANT LEGAL WORDS.:

* This tool is not an official product nor does it represent any commitment by IBM to
actually implement or provide a product such as this to the general public at a later date.

* Where can | get it?
+ IBM Graphical Workload Management (GWLM) Tool community in IBM
developerWorks
e https://www.ibm.com/developerworks/community/groups/service/html/communityv
iew?communityUuid=87992700-9b53-4137-83a5-1ed837e04858

Problems with GWLM can be reported to me with fixes, if any, being on a best-efforts basis when my “day job” permits....
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Installing GWLM

* Prerequisite

IDUG Db2 Tech Conference NA 3 #IDUGDb2
Philadelphia, PA | April 29 - May 3, 2018

* GWLM runs under the Adobe Air infrastructure so you will need to download
and install Adobe Air in order to use this tool (http://get.adobe.com/air/)

* Steps to install GWLM

1. Download latest GWLM zip file from community (@6 MB)

2. Unzip the file

w

Double-click on the windows installation file (GWLM-Install.msi)

Installing GWLM will put an icon on your desktop
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w4 XPS Viewer
¥ Zap Notes

4

7-Zip

Accessories
Administrative Tools
AT&T Global Network Client
Box Sync

Canon U Network Utilities
Canon MXB870 series
Canon Utilities

Cisco

Connect2

CrashPlan PROe

Diagram Designer

Graphical WLM

=7 Graphical WLM 3.0.4

ReadMe.pdf

IBM Personal Commun
IBM Sametime Connect

Back
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Icon created on your desktop

Graphical WLM added to your

@Oq » Computer » LocalDik (CIR Program Fikes 6) » BM » GraphicaMWLM »

Organize v

~l ®

Include in kbrary v

al

Leotus
My Help

Personal Comenunicati

R ———

Share with v New foider

docs.
METADE
Resources

Geaphic

Geaphuc.
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Invoking GWLM

View  Setup  Melp Provebed As-1s

1112 CumemtOB:  (none) Imported from:  (mone)

Statement Thresholds  Work Class Sets  Work Action Sets  Werkioads

s s Cewramrenmone J ]
| e ] ] [Cooeranmware] |
Sl E —

— _— E _

To invoke GWLM, just click on the icon and the main screen will come up showing the current default Db2 configuration (i.e. the one first introduced in
Db2 10.5). This screen is the anchor screen for GWLM and it is from here that you will explore and manipulate the configuration.

The next few slides take you through the key features of this screen.
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Overview screen

Provided As-is

. View  Setup  Malp

1o wim Thrashold_test.txt

08 Version:  11.1.3 CumentDB:  (mone) Imported from: Test Ci\Users\IBM_
Overview  Statement Thrasholds  Work Class Sets  Work Action Sets  Warkioads

a0om Tioo |3

Database Work Actions It A =
J — SYEDEF AULTMANAGEDSUBCLASS
Cotabase .z..{..4 _. SYSMANAGEOQUERIES | A.V\_ E
ﬂ SYBDEF AULTADMWORKLOAD I
Statemant Theeshold Stats
°
: | svsoerauTMAINTENANCECLASS | | _
| SYSOEFAULTSYSTEMCLASS | _. - ), _ _

Workload

Service superclass
Service subclass

The first thing to learn is how the key WLM entities are represented. The flow of work is from left to right with the workload definitions represented by
blue rectangles, the service superclasses represented by light green rectangles and the service subclasses represented by the darker green rectangles
within the superclasses. You will see a connecting line from the workload directly to the service class associated with it in the workload definition.

For each of these, the defined name of the entity is shown within the object.
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Overview screen (2)

*  1BM Graphical Workioad

View  Setup  Melp Provided As-is

1.3 CumentOB: (mone) Imported from: Test Ci\Us

BM_ADMIN\Docume

1BM Work\Optim\Graphical WLM\db2lookfdes\Thre:

Work action set

Statement Thrasholds  Work Class Sats  Waork Action Sets  Workloads

1\ i [(eonmmamaceomeane ] |
e ==
—— :m_ /
Work class + action(s)
VWOHGldoo aHOH{S)
_ SYSOEFAULTMAINTENANCECLASS E _
S ——— | _

Threshold

Work action sets, if they exist, are shown using an orange outline within the object on which the work action set is defined.

Here, we have an empty database work action set and a service superclass work action set defined in the SYSDEFAULTUSERCLASS service superclass.
There are no workload work action sets in this configuration.

Within the work action set, each unique work class used by the work action set is shown as a dark green rectangle within the orange outline along with
the name of the work action. Yes, | said work class name not work action name... this is to allow multiple actions defined on the same work class to be
represented simply.

Each action defined on the class is down by a an icon or symbol within the work class object area. In this example, we have a work action which maps

incoming work, including nested activities, to a specific service subclass, so you will see M within an orange diamond and a line to the subclass where the
mapped work goes.

Thresholds are shown as purple rectangles within the entity on which they are defined along with an icon representing the type of threshold and the
actual threshold value. In this case, we have a database threshold on UOWTotalTime for 2 minutes and a CPUTime for 2 minutes defined on the
SYSDEFAULTUSERCLASS super service class.

12
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Help in figuring out the different icons & symbols

" IBM ical W Manag Tool (GWLM) —— x
F g -P Thresholds.
ile Edit View Setup Hal - \\ . . . .
] oncurrenc e ova .
OB Version: 11.1.3 Current DB: Alwa-wiz S ! 1
- e o ConcurrentOBCoordActivities ActivityTotalTime SQLRomResd tstimatedsQiCost
About '
O Y

#+]11) #Q 8 e

ConcurrantworkioadActivites ActrtyTotalRunTime SQLRovaReturned SQLTempSpace
[eefufS] #Q 88 £
c actityT s sQui
#SD 8D *
TotalsCParitionConnections UOWTotalTime DataTagsinse

+o10 T._m\v L] aU

TotalDBParitionConnections

82

STOPEMCUTION Adhies Commsion Queve  Remep
Commaon Symbols . ﬁvﬂ -. E U
Work Actions.
Map activity WITHOUT NESTED Collect aggregate activity data Count activities
& z W
" 3t @® Close

Don’t worry, you don’t have to memorize all the symbols and icons! If you click on the Bestiary option under the Help menu, you will see a handy display

of what each represents.

There are icons for threshold type shown in the top half and as well as ones for all the possible work actions that can be defined.

13
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Overview screen (3)

08 Version 1113 CumentOB:  (none) Imported from: Test Ci
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Thrashold_test.txt

e S s _ Wb | Wt soe et | 4— 12DS 10 secondary screens
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et oy - \

Oatabase Thrashoids

Statement Thrasholds:  ©

Unique Statements:  ©

Sretamans Thosshod oo

L — \x_” SYSOEF AULTMANAGEDSUBCLASS
— el
=== & ] [Crmmmmmane |
e =l
e )
[Crmmmmmmnnes — _
(oSveosraszsvaCARS |
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The final two features | want to show you on this main screen are the slider bar that can be used to scale the image up or down to help you explore

extremely complex configurations and the series of tabs at the top that allow you to access some secondary screens which are useful for specific actions

that I will talk about later.

14
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Getting Started!

1 Generate PDF...
Print
Exit

Import XML from r.o.ﬂ. [

Import special...
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|| SYSDEFAULTMAINTENANCECLASS | —
Tool Import From Database x

- - ' -

File Edit View Setup Help - p=—tg

. - Fill in the connection info for the database you want to import from. ve

o Import P | Import from DB... =memwmppE® =

e User 1D and password are kept in memory only and discarded at the —
xport » Import DDL from file... Sets end of the session.

Generate >

Most name or 1P localhost

name

anlab.ib

Port number 41987 H
User 10 pbird

Password

Connect

Cancel

[e—

b Trackone
b We Fango
b wam

Fin pama oy cumtcomars b 2oobl wim

== // Output from “db2look —wIm”

Let’s get on to the good stuff! Now that you have installed GWLM, you probably want to bring in an existing WLM configuration to try out the tool.

GWLM provides two ways to bring in a configuration: you can have GWLM connect directly to a database and bring it in or you can point GWLM to the
output file from an execution of the “db2look —wim”.

15



- 1DUG IDUG Db2 Tech Conference NA
‘ Leading the DB2 User Philadelphia, PA | April 29 - May 3, 2018
Community since 1988

Exploring a configuration
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08 Vermion:  9.7.0 Cument OB (nens) Imported bom: Test Ciisers\1BM_ADMINIDocuments\ 18N Work\Optim\Graphicel WLM\4B2ioetsias\ACHE bt

Overview | Statemest Thresholds  Work Clase Sets  Work Action Sets  Workloads

[_coanos_wi

Ootatose Thoeshoiss

[omumscn v |

[

e

SYSOEFAULTUSERCLASS
ORI )

(=

e

_ svsor A ravaTInCLASS
(evsceramsvormanss |

Here’s an example of what you might see after importing in an existing configuration.

Right away, you can see a number of important things at a glance:
- what workloads are defined and where they direct incoming requests
- what work action sets exists and whether they redirect work coming to the service superclass to a specific subclass
- what thresholds are defined and where

Very quickly, you can understand what is in play and where you may want to focus your attention... but often the “devil is in the details” for WLM and
you need to look at specific definition details.

You can get those details by clicking on the name rectangle of any entity.

17
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If we click on the name of a workload, the pop-up workload details object appears.
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Exploring workload details (cont.)

rALN_sC 5 mALN_sC -
| (maAswe0) = ‘ I (MAPPED) =
: E : B
£ 4
- & @
e oree ' k2 dogree ks
o=~
[ | D
| I'I [ """Ill g
Bl |acanionat connection atnibud® IR S — v ) [ Add | [ Cleanue 1
ystem User | ASO | e ’
v (el
W -
| can
|
Without Hstery =
| Without History =
| | Wome v

The initial screen contains all the details about the workload definition and basic control options. You can find the other connection attributes in the
drop down menu which chows “IP Address” in this example.

To see the monitoring controls for the workload, click on the Monitoring tab

19



- 1DUG IDUG Db2 Tech Conference NA Wy #IDUGDb2
v Leading the DB2 User Philadelphia, PA | April 29 - May 3, 2018
Community since 1988

If we click on the name of a service class, the pop-up service class details object appears.

20
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Exploring service class details (cont.)
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Dalete

x
Sarvice superclass namae:

Service Subclass Details
Service subclass name

x
New Delete
Service superclass namae:
SIMPLE_SUB_SC
Enable service class:  [V]
o
Resources  { Monitoring

Service subclass namae:
""‘ l"'

SIMPLE_SUB_SC
Enable service class:

(4]
Resources Monitoring
-
- —— -
Agent priority -32768 ﬁw Collect activity data: [_]
Buffer Pool Priority Default v | Member: -
Prefetch Pricrity: | Default | v |
Outbound correlator
Collect Aggregate Activity Data Extended v
Histogram templates for collection Edit
Collect aggregate request data for monitoring: | None | v |
##HmH_ | #.u._ ____ J
100 100
The initial screen shows the service class definition and resource controls.
To see the monitoring controls for the service class, click on the Monitoring tab

In this example, you can also see that the icon for any threshold defined on the service class appears at the bottom and this can be used for direct access
to the threshold (in addition to the one shown on the main screen). This is true for workloads as well.

21
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mx_u_o::m threshold details

:_-

_EF‘

Collect Aguregete Aoty Cota: | Entemded

Mistogram tempistes for cotection: [ _Sdm

Cotant sppresate et date fer mentaning: | Weme |

If we click on the name of a threshold, the pop-up threshold details object appears.

22
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Exploring threshold details (cont.)

Delete

concurrentDBCoordActivities threshold on subclass SIMPLE_SUB_SC **EE

Limits the number of concurrent coordinator activities.

Threshold name: _ SIMPLE_THR

Limit for number of concurrent activities:

100

Unbounded queue length _N_

Queued Activities | 0 _@

Collect activity data: [ |

Member: | Coordinator |v |

Stop the activities that exceed the limit

u

Enable threshold E

Y #1DUGDb2

This is a bigger picture of the threshold details pop-up menu.
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Exploring work action set details
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A work action on the main screen shows the series of work classes for which actions have been defined and then has icons or symbols to represent the

actions associated with that work class in this work action set.

If we click on the name of a work class, the pop-up work action details object appears.

24
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Exploring work action set details (cont.)

Details of Work Class and Associated Work Actions X
New Delete Associated work actions
Map activities
Work class name: MED_WC
Type: DML - Work action name: MED_MAP
M Map to subclass: MED_SUB_SC I
easure: Timerons v
T —— Map vith nested: |V
From: 50000 S Biaa x|
— Enabled: V]
To: 2000000 @ || Unbounded
Evaluation position: 2 @
Number of work action sets referring to this work class: 1

This is a bigger picture of the work action details pop-up menu. It has both the work class definition and, to the right, will be listed all the associated
work actions (with their names!) as defined in the work action set. Each work action will be in its own dark green box.

25
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Overview | Statement Theashobds | Wark Class Sats f_..l.t.l.t..ﬁ [RR—.
| e Owate ,'l‘\

[ [P ——— [—— Action Type
vommws e eamse

CCCChC

Wark action set nama:  HAIY

Work class sets | MAIN
AR
Enatie work action set

s [P ——
s s
Vo ane mamt e
o (o iv X
lom o)
o —— R
(e v) oseE v
e > I e T
T & Urtounded - <
=«
Sohaven peomen T L3
e of mark s oot refeming 10 Wi s dosss

If we want to look at the work action set as a whole, you can click on the work actions sets menu tab and you will be taken to this screen where you can

view all the details for the work action set and its current work actions in one place.

The details for the current selected item of interest appear at the bottom.

26
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Exploring work class sets

- Ve Sens e Previded A
08 verwio: urvans OO }T\vﬂu”li. naraiian, -
Overvew  Stetemant Thewshotds f..(:r..t.. P At sets | werttente
mew _ten__utere it
St some Po— - [RraR— Matarences Lo — . . Outa tan
CacoLTves o vven:
ram_we rasn_we
) simee_we e we om TimmmoncoST ° 50000
Dyweo_we o_we om Tiwenoncost 0000 2000300
Ocome_we oms_we om enoncosT 3000000 '
Qwarrewe e w y
Doowwe cowwe oon

Similarly, you can do the same ting for work class sets using the work class set menu tab.

27
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Modifying a configuration
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Making changes to existing objects

* Changes can be made on any of the detailed pop-up menus that we

just looked at... simply go ahead and modify them!
* Changes take place immediately

* For database-level objects, you can also use the Edit option under
the Edit menu s spicl Workiosd Management Tool v I

File{ Edit Miew Setup  Help
'~ / |

DB Versia zmls » vU Imported from: Test C:\Users\IBM_ADMIN\Documents\IE
Tt TS » hreshold
I
O<n:L~I ¢ DB Thresho * | Action Sets | Workloads
‘Datere 4 DB Work Action Set

10% Reset to factory defaults Histogram Template

W

—_—— Work Class Set

Database Work Actions

P

29
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Adding new database objects

* New database level objects can be created using the New option
under the Edit menu:

Fils#  Edit SV% Setup  Help |
7

DB Verdh New _g 4 DB Threshold » |ADMIN\DocL
~me
1 it > Acti
Overvil DB Work Action Set Wor
Delete 4 Histogram Template :
10% Reset to factory defaults Service Superclass
o
—_— Service Superclass (BP template)
Workload
Database Work Actions
Work Class Set
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Adding new objects (workload and service class)
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* To create new objects under other existing objects, choose the New
optionin the top menu in the object:

' Workload Details
-
| a\\:n.. I Delete

NEdit
—
1S aGleth (this) workload

| Threshold »

Work Action Set...

Target service subclass:

| ActivityTotalTime
ActivityTotalRunTirr
CpuTime

ConcurrentWorkloa! aIlM.“.Kh.: subciens

Service Subclass Detaids
H -
1.7

Default service subcl
Evaluation position:
Enable workload:
Allow DB Access:

Maximum degree:

c —
EstimatedSQLCost
SqlRovsRead
SqlRovaReturned |
SqlTempSpace

UowTotalTime
e e

Agent priority

Buffer Pool Priority:

Prefetch Priority:

|
1

Activity TotalTime
Activity TotalRunTime
activity TotalRunTimeInAlISC

AggsalTempSpace

CpuTime
CpuTimeInsc
OataTaginsc
EstimatedSQLCOSt
SalRowsRead
SalRowsReadInGC
SalRowaR eturned
saiT.

o

Service Superclass Details
o
( New wn;

~
= =efBiie (this) service superclass

Delete

Subclass
| Threshold »
\Wiarls Action Set...

Agent priority: | -32768
fer Pool Priority: Default
Prefatch Priority: Default

ound correlator:

gl

i

ActivityTotalTime
ActivityTotalRunTime
ConcurrentDBCoordActivities
ConnectionldleTime
CpuTime

EstimatedSQLCost
SqlRovsRead
SqlRovsReturned
SqlTempSpace
TotalSCPartitionConnections

TITETTT TIPS T T———

UowTotalTime
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Adding new objects (work class sets and work classes)

|__File Edit View Setup Help |

ool (G

OB Version: 9.7.0 Current DB: (none) Imported from: Test C:\Users\IBM_ 18M Work\Op!t wim ACME.txt

| ohoh“l.lgﬂi'tn Work Class Sets Work Action Sets  Workloads
-~

-
A4 New Edit  Delete II

Y 4
[} - Haw viork class set e o ercnk gJgzs name Type Eveluation order References MNessure Fn
\ Now vork class in selected | 'lllll
- i e = = MAIN_WC IIII
L SIMPLE_WC SIMPLE_WC oML " 1 1 TIMERONCOST o
) meo_we MED_wC oML \ 2 1 TIMERONCOST 30000
|2000000 |
L WRITE_wWC WRITE_WC WRITE - - 1 o
) woao_we LOAD_WC wao | s 1 o
Qoo we ooL_wC L]
Canew_wcs new_wcs | Work Class Set ‘ x

Work class set name: NEW_WCS

Work class Evaluation
ety Type " References Measure From Yo Schema Data Tag

Work classes and work class sets can be modified or created on the associated menu screen. To create them, click on the New menu option and choosing
what you want to do.
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Adding new objects (work action sets)
w!‘?l'twl 8 Workload Details : Service Superclass Details
File p Edn " View Setup Help
o8 versia  Mem »| 08 Threshold , New Edit  Delete N Gt Oclete
- N v e
vt % ’ ”...H...;JHH. IIIII Clone (1his) soddos Clone (this) service superclass |
108 el 000t to factery defois Service Superciass N, N Threshold NE 1 Subclass
e — Service Superciass (82 template) Threshold »
T s ) R i
bt Work Class Set 1 : \ on Set... o
\ ; I
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Work action sets can be added to all relevant objects (database, workload, service superclass) by using the New option in the object sub-menu or going

to the Work Action Set menu screen and choosing the option you want there.
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Adding new objects (new work action for old work class)

MAIN_SC

SIMPLE_SUB_SC

_ <m
SIMPLE_WC :

st 0]

Details of Work Class and Associated Work Actions

J8

MED_WC
“ - -~

New \Vm_mnm _

i

Count action
Collect activity data action

Collect aggregate activity data action

Prevent action

)

v _ DDL_WC

To: 1@ | unbounded

juntion postions 1 o)

Number of work action sets referring to this work class: 1

Associated work actions

Map activities

Work action name:
Map to subclass:

Map with nested:
Enabled:

SIMPLE_MAP

SIMPLE_SUB_SC

v

NN (e— ]

When there is an existing work action set which uses the work class to which you want to add the new work action, you can simply modify the existing

work class from the main screen directly and add additional actions to it.
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At Type

To add new work actions for work classes not currently being used in the set, go to the Work Action Set menu and select the work class you want to

define the work action upon.
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Removing objects

* Just use the Delete option in the same menus where you found the

New option
* You can delete contained objects or the object itself
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Generating DDL

View Setup  Help

»
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3 » ; Generate new DDL mam e wee W8

Generate delta DOL wy
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Ganarated (Naw) by GWLM Versien 3.0.4 Budd laved 171012
Cotabase Masager Varman: DB2 LW Verwen 11.1.3

5 w5

LMD WL SESSION USER] CuANGE_MEIT)
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* This menu has many useful options!

Tl —

File Edit View Setup Help

DB Version: 9.7
Overview A
v

10% v
WO

—_—l— v

v
7 Database Worl

Refresh

Database Version...

Show concurrency thresholds
Show time thresholds

Show row thresholds

Show other threshold

d from: Tes

s Sets w

Show unused objects

Close all pop-ups

Database Thresholds

Y #DUGDb2

The View menu on the main screen has several useful options that you should know about...
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View menu: Database version

Fle KR View  Setup  elp
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1512 Cument 08

(none) Imperted from:  (nome)
Overview  Statement Thrasholds  Work Class Sats  Work Action Sets  Worbloads
10

400m oo |3

Statement Threshsld Stats

Statement Theasholds:

Uniave Statements:

Oatabese Masor Version.

purescale Database

08 version.

10.1.0 Cument 08

(none) tmported from:  Fie

v S it [t i e e i
g
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B
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SYSOLFAULTUSERCLASS
-
Ouee VIO A )
o

SN
A Al _ 7’
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A quick point about something | said earlier. Db2 has changed its default configuration over the years and although GWLM by default will assume the
most current default configuration, you can change that assumption by using the Database version option under the View menu. Similarly, GWLM will

attempt to recognize the version of any imported configuration and properly reflect the default configuration for that version.

The example here shows how the two default configurations are different.
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Version-sensitive context

Db2 9.7

New  Delete

Service superclass name:

Db2 10.5

x Service Subclass Details x

New  Delete

Service superclass name:

Service subclass name:

Enable service class: v

Resources Monitoring

Agent priority:  -32768 ﬁuu

Buffer Pool Priority: | Default | v
Prefetch Priority: Default v

Outbound correlator:

Service subclass name:

Enable service class: v

Resources Monitoring

Agent priority:  -32768 »u

Buffer Pool Priority: Default -

Prefetch Priority: Default | v
Outbound correlator:

Pl . -~
- [r—— ~
27 CPU Shares: 1000 = | S
’
7 CPU share type: | Hard | v /—
! Apply a CPU limit: || 1
\ R
~ CPU Limit (%): s ’ 4
% -
rd e
-~ - -
-
~ - - -
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View menu: Show unused objects

By default, GWLM will hide many objects that are not being used as they don’t contribute to what is actually going on within the configuration. To see
them, you need to select the show unused objects option in the View menu. You can see on the right the objects that were not shown in the default
display because they were disabled and not active.
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View menu: Show unused objects (cont.)

Database Thresholds

Disabled indicator

Here is a closer look at the objects that were not present in the default display. Notice the red ‘x” symbol for objects that are not enabled in the
configuration.
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To get rid of a pop-up menu, you click on the ‘X" in the top right corner. If you have a whole bunch of them opened, you can close them all using the Close

all pop-ups option in the View menu.
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BM Grapiical Workdoad
spm; - J,i

10% Reset to factory defachs Servce Supardass

L e—

Database Work Actons.

Another item that may be of interest is the ability to choose a service superclass based on the WLM best practices template from the New menu. This
option lays a service superclass which uses the recommended starting template from the WLM best practices.
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Warnings -
/ Warning indicator

— /

-]
L

_ BYPASSCOST_WC | .E

n__n.:..:...;.i:.:.:s:lin_.:A’[ “Hover” IO_U
_ QUERYCLASS1_WC — |
_ QUERYCLASS2_WC — @LL/ \

-

\
\

There is an overlap of from/to timeron cost values
, between the range of this work class and another
- - v one.

-

QUIRYCLAY

]

You may have noticed a yellow exclamation point symbol in a couple of screens. These indicate a warning condition that GWLM has detected. For many

things in GWLM, you can find out more about them by hovering your cursor over the item to see the “hover help”. In this case, it tells you to click and
what you are presented with is the text of the warning condition that was detected
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Parsing errors

* On rare occasions, you may see parsing errors from GWLM

lne 1743: CREATE SECURITY not

-- DDL Statements for Security Label Component "SECURITY LEVEL"

ARRAY ['HIGHLY CONFIDENTIAL',
'CONFIDENTIAL',

"UNCLASSIFIED']; Unsupported SQL

“v CREATE SECURITY LABEL COMPONENT "SECURITY_ LEVEL" d/
L

CREATE SECURITY

CREATE _H.EWMW‘Q“UIQUmlmOEHQWEOle.O_H_HdOH%OIOOZOIEH.lOOQQﬂI.HE:
FOR WORKLORD SH.|OH__H<0NM~|OH.W NrnWﬂ<HH_HNm
NZ@ONOEZ%EBNN \\\
THORRLORSCCCURRENCES > 600
Error near line 1376: CREATE THRESHOLD on -* WHEN, (CONCURRENTWO
unknovwn workload WL_GTIVORY_OLB pa COLLECT ACTIVITY DATA
Context: ON COORDINATOR DATABASE PARTITION

. WITH DETAILS db2look —wim UCOAJ

CONTINUE;

While no tool Is perfect, sometimes it is not GWLM’s fault! © There are a few cases where the db2look output has problems and GWLM chokes on the
input file... or the input file contains things that GWLM doesn’t support. In these cases, you will see one or more error pooping up during import. You can
click OK to make them go away and the final result may be usable but in general, | recommend that you trim out or correct the input file until GWLM can
consume it without error.

The examples here show:

1) db2lock output has LBAC definition DDL in it which GWLM does not support

2) db2look forgot to put quotes around a mixed case name! GWLM couldn’t find a match to the name in the threshold definition since the original
workload name was mixed case.
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Known limitations: Functional

* Assumes default DB2 WLM configuration with default concurrency

threshold disabled
+ Does not reflect DB2WORKLOAD=ANALYTICS or environments with different defaults
such as Db2 Warehouse

* Comments for any workload objects are not shown and cannot be added
* Workload usage privileges are not modeled

* Support for statement thresholds is limited:
* No ability to modify statement text
* No ability to create new statement text thresholds
* No support for generation of delta DDL
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Known limitations: Print

* Print and Generate PDF options are fairly crude
* The print capability is limited to the currently displayed screen
* The Generate PDF option produce a series of vertical screen images and does
not compensate for configurations that exceed the display screen horizontally

* To minimize the impact of these limitations, you can reduce the size of the
displayed image using the zoom slider
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[ use this tool frequently to look into strange, unknown Wim
configurationsthat | am sent and it saves me tons of time in

understanding the overall configuration!
-Paul®

Withthis tool, [ can quickly put together a configuration
proposal and the generate DDL feature saves me from having
to look up all the syntaxin the does! t Love GWILM!

= P, B,

[ have found nothing better in the market at this pricepoint!
- Anonymous IBMer
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